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Copyright Notice

The use and copying of this product is subject to a license agreement. Any other use is prohibited. No part of
this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into
any language in any form by any means without the prior written consent of us. Information in this manual is
subject to change without notice and does not represent a commitment on the part of the vendor. We do not
warrant that this document is error-free. If you find any errors in this document, please report to us in writing.

This product includes software developed by the Free Software Foundation, Inc., (http://www.gnu.org/). GPL
Ghostscript is a free software: you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation, either version 3 of the License, or (at your
option) any later version. It is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License in http://www.gnu.org/licenses for more details. Ahsay has not modified any code
of GPL Ghostscript, and Ahsay has not made any charge related on using GPL Ghostscript.

Trademarks

©2015 Ahsay Systems Corporation Limited. All rights reserved.

Ahsay, Ahsay Online Backup Suite, Ahsay Offsite Backup Server, Ahsay Online Backup Manager, Ahsay A-Click
Backup, Ahsay Replication Server, Ahsay NAS Client Utility are trademarks of Ahsay Systems Corporation
Limited.

Microsoft, Windows, Microsoft Exchange Server and Microsoft SQL Server and all Windows-based trademarks
are registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners..

Oracle, Oracle 8i, Oracle 9i are registered trademarks of Oracle Corporation.
Lotus, Domino, Notes are registered trademark of IBM Corporation.

Red Hat, Red Hat Enterprise Linux, the Shadowman logo and JBoss are registered trademarks of Red Hat, Inc.
www.redhat.com in the U.S. and other countries. Linux is a registered trademark of Linus Torvalds.

Apple and Mac OS X are registered trademarks of Apple Inc.
NetWare® is a trademark of Novell, Inc.

All other product names are registered trademarks of their respective owners.

Disclaimer

Ahsay Systems Corporation Limited will not have or accept any liability, obligation or responsibility whatsoever
for any loss, destruction or damage (including without limitation consequential loss, destruction or damage)
however arising from or in respect of any use or misuse of or reliance on the AhsayOBS billing program. By
using the AhsayOBS billing program, you agree to accept unconditionally the terms of this Disclaimer and as
they may be revised and/or amended from time to time by Ahsay Systems Corporation Limited without prior
notice to you.

License Agreement
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1. All software provided by Ahsay are on an "as is" basis with no warranties of any kind and Ahsay will not
be liable for any damages of any kind arising from the use. Ahsay further disclaims all warranties, express
and implied, including without limitation, any implied warranties of merchantability or fitness for a
particular purpose.

2. Ahsay shall not be liable for any indirect, special, incidental or consequential damages (including damages
for loss of business, loss of profits, loss of backup data, or the like), whether based on breach of contract,
tort (including negligence), product liability or otherwise, even if Ahsay or its representatives have been
advised of the possibility of such damages and even if a remedy set forth herein is found to have failed of
its essential purpose.

3. Ahsay grants you a non-exclusive, non-transferable, royalty-free rights to use the binary form of this
software solely for the use of billing backup service subscriptions powered by Ahsay Offsite Backup
Server, provided that your subscription to the software support and maintenance program of Ahsay
Online Backup Suite has not been expired.

4. Redistribution of this software programs owned by Ahsay, unless explicitly granted by Ahsay, is strictly
prohibited.

5. Any attempt of reverse engineering, disassembly, or de-compilation of programs, unless it is explicitly
permitted, is prohibited by law.
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Getting started

Introduction

This manual contains instructions of how to install and use the AhsayOBS billing program provided by
Ahsay. It is assumed that you have not modified the code or the structure of the program. Some
instructions are applicable only to the raw resources provided by Ahsay.

Different symbols are used throughout this document to classify different types of values:
1. Double-Quoted: objects in the file system or special phrases
2. Square Bracketed: keywords in the Excel and Windows interfaces
3. Single-Quoted: existing cell values or values to be inputted on the Excel worksheet
4.

Italic: programming code

Requirements

The program requires installation of other softwares, including the followings:

1. Microsoft Excel (version 2000 or above) installed in a Windows OS with VBA enabled. Please
check the hardware/software requirements of Microsoft Excel in the website of Microsoft,
http://www.microsoft.com.

2. AhsayOBS (version 5.2.4.0 or above) installed on any supported OS, with the billing module
enabled. It is NOT necessary to have AhsayOBS installed on the same machine of the billing
program. It just requires a few more steps to install the billing program on a machine other
than one where AhsayOBS is installed. Please refer to the section of Installation Instructions,
step 5, for more details.

3. In order for the billing program to work, the corresponding AhsayOBS license must have an
unexpired support date. If the AhsayOBS support date has expired, the billing program will
stop working. Contact representatives of Ahsay (https://forum.ahsay.com) if you wish to
extend the support expiry date.

4. Software, which can extract zip files, has to be installed. It can be installed on any machine.

Software Download

Partners can download the billing program from the following link.
http://www.ahsay.com/download/customer/software/billing/current/billing.zip .

Directly download the file as a zip file, and it will be ready for installation.

Installation Instructions

Please follow the procedures below to install the program:

1. Extract all files in the zip file provided with any software that can extract zip files. Keep the
structure of folders and files, and put them in a folder, e.g. “C:\bill”.

2.  Run “msxml.msi” to install MS XML. Default settings are adequate to the billing program.
3. Add a postscript printer in Windows. To do this,

— Open [Control Panel] from the [Start Menu]

—  Click on the icon of [Printers and Faxes]

—  Select [File] -> [Add a printer] from the menu

— Choose [Local printer attached to this computer and then press [Next] to continue.

— On the page of [Select a Printer Port], choose [FILE: (Print to File)] under [Use the
following port]. Click [Next] to continue.

— In the given list, choose any of the printers with the words [PS] at the end of their
names, e.g., [HP Color LaserJet 8500 PS]. Then click [Next] to continue.

— Accept all default settings, and the printer will be installed correctly.
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4. Look in the directory where the unzipped files are extracted to, open “GPL_Ghostscript.reg”
with notepad and modify the paths according to where the unzipped files are extracted to. For
example, if the path of the extracted files is “C:\bill”, then the file should be modified as

"GS_DLL"="C:\\bill\\gs\\gs8.57\\bin\gsdlI32.dIl"
"GS_LIB"="C:\\bill\\gs\\gs8.57\\lib;C:\\bill\\gs\\fonts; C:\\bill\\gs\\gs8.57\\Resource"

5. After saving the “GPL_Ghostscript.reg”, double-click it and Windows will ask if you want to
install it to the registry. Press [Yes] to confirm.

6. If the billing program is going to be used in a machine other than the machine where
AhsayOBS is installed, you will have to enable the billing module for external access. To do
this,

—  Open the path where AhsayOBS is installed.
— Open the file %60BS_HOME%\webapps\obs\WEB-INF\web.xml with a text editor.

— In the file, find the tag of <filter-name=Bill</filter-name=>, which is placed inside the
tags of <filter> and </filter>. There are two IP ranges which specify the IP ranges which
are allowed to have the access right of the billing module, inside the tags of <init-
param> and </init-param>.

— Add/Change the IP ranges if necessary. For example, if you want to use the billing
program in a machine with IP address of 192.168.1.1, append another set of <init-
param> tags inside the tags of <filter> and </filter> like this:

<filter>
<filter-name=>Bill</filter-name=>
<filter-class>com.ahsay.obs.www. IPFilter</filter-class>
<init-param=>
<param-name>Rangel</param-name>
<param-value>localhost</param-value>
</init-param>
<init-param=>
<param-name>Range2</param-name>
<param-value>127.0.0.1-127.0.0.1</param-value>
</init-param>
<init-param=>
<param-name>=>Range3</param-name>
<param-value>192.168.1.1 — 192.168.1.1</param-value>
</init-param>
</filter>

—  Save the file and restart the AhsayOBS service.
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Understanding this software

File Structure

There are 5 files and 2 folders included in the program. They are included in the zip file provided.

211 Files

There are 5 files contained in the root:

Files included

The Excel workbook which stores the company information, user
records and pricing plans

The Excel workbook which generates bills and sends emails

The registry information which is required for GPL Ghostscript.
If you would like to install GPL Ghostscript by the wizard, you
can download the whole GPL Ghostscript (version 8.57)
program from the website http://pages.cs.wisc.edu/~ghost/.
You may then delete this registry file since it is included in the
installation wizard provided by GPL Ghostscript.

The installer file of MS XML 4.0 SP2. Please read the license
agreement carefully before installing, where the agreement is
included in the installer. For more details about the MSXML 4.0
SP2 package, please visit the Microsoft download page
http://www.microsoft.com/downloads/details.aspx?familyid=31
44b72b-b4f2-46da-b4b6-c5d7485f2b42&displaylang=en or visit
http://www.microsoft.com, the official website of Microsoft.

This user guide

The “OBS-BiIll.xIs” requires information of “OBS-Records.xIs”, and therefore “OBS-Records.xIs”
must be opened for “OBS-Bill.xIs” to work. Although it is not a must, it is recommended to
open “OBS-Records.xls” before opening “OBS-Bill.xIs”; otherwise, some warning messages
may pop up, though they are ignorable.

2.1.2 Folders

There are 2 folders included:

Folders included

The folder which contains the installed files of GPL Ghostscript. If you would like to
install it by the wizard, you can also download the full GPL Ghostscript program
(version 8.57 or above) from the website http://pages.cs.wisc.edu/~ghost/. You may
delete this “gs” folder if you choose to download the full program.

The folder which is used to store the PDF files generated by the program. If you have
deleted it, the program will generate the folder again when generating PDF

Data model

This part gives you information about the data model of the billing program. It is important to
understand the data model, in order to customize the program correctly.

There are mainly two models: Company and User model and Condition, Condition Group, Pricing and

Package model.

221 Company and User
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The billing program is designed for billing companies. As there is no such information in
AhsayOBS, you will have to define it in the billing program. The architecture is very simple:
each company consists of a number of users.

2211

Company

From the point of view of the billing program, a company is actually a group of users.
Bills are subjected to companies instead of users. One bill can only be subjected to one

company.

Each company should carry the following information:

Fields of company

The identity of a company. There is no restriction on what format
the ‘Company ID’ should be, but it must be unique in the
[Companies] worksheet.

The starting date that the company has joined your plan.

The name of the company.

The pricing package assigned to the company. You may leave it
blank and more details on creating pricing packages will be provided
in the section of Package.

True if the company is going to be charged. False if you want to stop
charging that company.

The company correspondence address.

The country of the correspondence address.

The contact person of the company.

The email address of the company. It is important because the
billing system will send bills to this email address. You can have
multiple recipients, with names or without names, e.g.
“accountl”<accountl@mycompany.com>,
account2@mycompany.com.

The contact phone number of the company.

The credit card number of the company which is used for payment.
Input if applicable.

The expiry date of the corresponding credit card. Input if applicable.

Anything you would like to record about the company, e.g. the
status of the customer.

About assigning user to company, please refer to the User part.

2.2.1.2

User

Users in the billing program (called billing user below) are exactly the users in

AhsayOBS. However, in order to separate the actual work of AhsayOBS and billing, some

information of the user will not be exported to the Excel workbook directly.

Instead of using the imported information directly, a mapping worksheet will be given to

map users in the billing program to the users of AhsayOBS. In other words, AhsayOBS
users have the information of storage, bandwidth, modules details, etc., where billing
users (users defined in the billing program) relate the AhsayOBS users to companies and
pricing plans in the billing program.

AhsayOBS users will be mapped to billing users if their login names match.

Ahsay Systems Corporation Limited pgge 9 of 39
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Billing User

The following information of billing users should be provided:

Fields of billing user

Similar to ‘Company ID’ in [Companies], there is no
restriction on the format, but the user ID must be unique in
the [Users] worksheet.

The ‘Company ID’ that the user belongs to. Choose the
corresponding ‘Company ID’ from the drop-down box. By
giving this value, the user is assigned to the company
specified by the ID given.

You don’'t have to input this value. The Excel formula will
search the name for you. If you find that there is still nothing
appeared after you have entered ‘Company ID’, try to copy
the previous upper cell and paste it to the current cell.

The login name of the user. It is essential to have a correct
entry because this value will be used to map the list of users
in AhsayOBS.

Anything you would like to record about the user, e.g.
whether the user is inactive or not.

AhsayOBS User

The information of AhsayOBS users will be imported to the program. They are
separated by months. Every month when it is time to bill, the list can be
refreshed by clicking the refresh button provided.

The following information of OBS User will be included after importing from
AhsayOBS:

Fields of AhsayOBS user

the login name in AhsayOBS

Paid user or trial user

AhsayOBM user or AhsayACB user

Storage quota of the user

Upper speed limit of transferring data

Maximum storage size in the month, excluding
data in retention area

Maximum storage size in the month within the
retention area

Maximum uploaded file size in one backup job
in the month

Average storage size in the month, excluding
data in retention area

Average storage size in the month within the
retention area

Ahsay Systems Corporation Limited Page 10 of
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Average uploaded file size in the month

The total uploaded file size in the month

True if Microsoft SQL module is enabled

True if Microsoft Exchange module is enabled

True if Oracle module is enabled

True if Lotus Domino module is enabled

True if Lotus Notes module is enabled

True if MySQL is module is enabled

True if In-File-Delta module is enabled

True if Shadow Copy module is enabled

True if Exchange Mailbox module is enabled

The number of exchange mailboxes assigned
to the user

Registration Date of the user

Enable or Suspend

2.2.1.3 Overview of the relationship between Companies and Users

To summarize, the relationship between [Companies] and [Users] is:

Company
;I—/
1 1 1
[ Billing User ] Billing user [ Billing User ]
| R I |
[ OBS User ] f OBS User [ OBS User ]

-

J

A company may consist of many billing users, but one billing user will only map to one

AhsayOBS user.

The program will run several steps related to companies and users when it generates

bills:

1. Loops through the billing users assigned to the company.

2. Gets the information from AhsayOBS user, which should already have been

downloaded to the program.

3. Finds out the AhsayOBS information (e.g. storage, bandwidth) of the billing users,
by matching for the login name of AhsayOBS users with that of billing users.

Then the program can use the information to generate bills.

2.2.2 Condition, Condition Group, Pricing and Package

Condition, condition group, pricing and package are components of a complete pricing plan.
They are closely related and highly hierarchical.

If you find that it is difficult to understand the pricing setup, please refer to the Case Studies
section for a better understanding.

Ahsay Systems Corporation Limited Page 11 of
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2.2.2.1 Condition

The conditions are the basic elements for conditional pricing. The pricing will be chosen
only if the corresponding conditions are true.

Each condition consists of 5 fields:

Fields of condition

The identity of the condition.

The name of the field to be compared.

The comparison operations to be performed.

The value to be compared. You may use an Excel formula if necessary.

Anything you would like to record about the condition.

2.2.2.2  Condition Group

Each condition group is made up of a number of conditions linked together with the logic
of "AND". For example, if condition A and condition B are both assigned to the same
condition group Groupl, then Groupl means “condition A AND condition B”.

This structure is useful when the pricing plan requires comparing multiple fields and
values.

Fields of condition group

The identity of the condition group.

The condition which is included in the specific condition group.

Anything you would like to record about the condition group.

2.2.2.3 Pricing

Pricing represents the price information of a condition group. Each pricing should carry a
definite method of price calculation.

You can also treat pricing as the mapping of packages and condition groups. Please refer
to the sections of Package and Relationships between Condition, Condition Group,
Pricing and Package for more details.

Each pricing consists of the following fields:

Fields of pricing

The identity of the pricing.

The short name of the pricing. It will be shown in
the bill so that the client will know under what
pricing scheme they are subjected to.

The package it belongs to. Package definition will
be discussed in the next section.

Condition group applied to this pricing.

The priority of condition groups. This is useful if
more than one condition group are fulfilled. The
highest priority of the fulfilled condition group will
be chosen.

Ahsay Systems Corporation Limited Page 12 of
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Treated as the unit of the unit price. If the value is
‘Fixed’, it will be the fixed price and not unit price
anymore.

The price under the corresponding condition
group.

If set to ‘TRUE’, this option allows pro-rated pricing
when the company starting date or the user
registration date is in the same month as the
billing date. For example, if the user registers on
15 May 2007, and billing for May occurs on 31 May
2007, then the user will be charged for 16 days
(16/31). The program still counts as 1 day if it is
less than 1 day.

The rate for each Exchange mailbox assigned to
users.

The description for Exchange mailbox charge
which will be displayed in the bill when the
corresponding pricing is chosen.

Anything you would like to record about the
condition.

2.2.2.4 Package

Each package is made up of a number of pricings. If the package is assigned to the
company, the program will loop through the conditional groups of each pricing inside the
package, and find the valid pricing with the highest priority. This structure enables

conditional pricing.

Each company will be assigned with a package. Each package consists of the following

fields:

Fields of package

The identity of the package.

It defines if the package is a group package. It is applicable
only if the pricing plan is designed such that:

- all users have the same unit rate,
- the charge for the company is a fixed constant, or

- conditions are subjected to the aggregate usage of the
whole company instead of each user.

This description will not be displayed on the bill by default

2.2.2.5 Relationships between Condition, Condition Group, Pricing and Package

To summarize, the relationship of condition, condition group, pricing and package can be
depicted of as in the following diagram:

Ahsay Systems Corporation Limited Page 13 of
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Company
|
Package
(. I J
| | P 1 < 1
[ Pricing ] Pricing [ Pricing ]
| ) I . I
[ Condition Group ] Condition Group [ Condition Group ]
_[ Condition ) Condition ] Condition ]

_[ Condition ) Condition ]
_[ Condition )

As shown in the diagram above, a package is assigned to a company, which consists of a
number of pricings. Under each pricing there is a condition group, and under each
condition group there are conditions.

When the program is triggered to generate bills, several steps related to the four
elements occur:

1. Look up the package that the company is assigned with (please refer to the section
Company about the relationship between packages and companies).

2. Loop through the layers of each pricing of the package and extract the information
from conditions, the bottom layer.

3. To find out if a certain pricing is applicable, the program checks if the conditions of
the condition group are true. To do this, the program joins all the conditions at the
bottom layer by different condition groups, to form a condition statement (please
refer to the section of Condition Group about how the conditions are joined). If the
condition statement returns true after parsing, the corresponding pricing will be
considered as applicable.
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How to use this software

This part contains the instructions about how to setup and make use of the program. It is assumed that
you have not modified any code or setting, and the environment is set as default.

If you find this part is too difficult, we can provide Hassle-free services, which help you to set up and put
your business logic into the program. Please read the section of Hassle-free Service for more details.

On defining items or inputting data, you cannot jump any line. Otherwise the program will treat that the
empty line as the end of the worksheet and stop searching the document.

Setting up the environment

Please follow the instructions below to set up the basic environment for the program.

1.
2.

10.

11.

Open “OBS-Records.xIs” with MS Excel.

Different security level of VBA have different effects to the program:

Effects of security Level of VBA

program will not work, and no prompt will be displayed.

Macros] to have the program works.

However, for security reasons, it is not recommended.

To set the VBA security level, select from the menu [Tools] -> [Macro] -> [Security], and then
choose your preferred level of security ([Medium] is recommended). After changing the level of
security, you may have to restart the MS Excel and re-open the file.

Open the worksheet [Constants].

In cell A2 (the cell under ‘OBS Server Path’), enter the full path of your AhsayOBS server.
Enter information on system user and system password as well. By default, the AhsayOBS
server path is ‘http://127.0.0.1’, while system user is ‘system’ and system password is
‘system’ (the text-color has been set to white for security reason).

Open “OBS-Bill.xIs” with MS Excel. Again, make sure the VBA security level is medium or low.
Open the worksheet [Constants] in “OBS-Bill.xIs”.

Column A contains some names about the worksheets in “OBS-Records.xls”. Change these
fields ONLY WHEN NECESSARY. For example, if you have renamed the worksheet [Condition
Groups] in “OBS-Records.xlIs” to ‘Group’, you have to change the value of cell A12 in “OBS-
Bill.xIs” to ‘Group’ as well. Also, such a change also affects “OBS-Records.xlIs”; the drop-down
list of ‘Condition Group ID’ in [Pricings] will be no longer functional. You will have to change the
definition of the name of [CONDITION_GROUP_IDS] from the Excel menu [Insert] -> [Name] -
> [Define]. Due to the complexities involved, it is NOT recommended to change those fields.

Cell A16 (under ‘PDF_FOLDER_NAME’) of the worksheet [Constants] in “OBS-Bill.xIs” defines
the name of the folder which is used to store PDF files generated from the billing program. Feel
free to rename it to your desired folder name. The program will generate the folder if it does
not exist.

Enter the name of the postscript printer driver installed before to cell B2 (under
‘CONST_PRINTER_NAME"). If you have not installed a postscript printer driver, please refer to
the section of Installation Instructions and install the printer driver.

Enter the full path of the “gswin23c.exe” file in cell B4 (under ‘CONST_GHOSTSCRIPT_EXE"),
where the exe file is put under the folder “gs\gs8.57\bin” by default. E.g., if you have installed
the program in the “C:\bill” and the exe file is put under the folder “c:\bill\gs\gs8.57\bin”, then
you should enter “C:\bill\gs\gs8.57\bin\gswin23c.exe” to the cell B4.

Enter the SMTP mail server name (e.g. smtp.yourcompany.com) in cell B6 (under
CONST_MAIL_SERVER) and its port (e.g. 25) in cell B8 (under CONST_MAIL_SERVER_PORT).
In normal cases, port 25 will be used for SMTP mail server.
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Defining companies and assigning users

Before continuing, please make sure you have read the section of Company and User and have
understood the model.

It is recommended to do the following steps sequentially.

3.21

Getting usage data from AhsayOBS to the billing program

To get information from AhsayOBS server to the program, please follow the procedures below:

1.
2.

Open “OBS-Records.xIs”

Make sure that your AhsayOBS is running, the billing module is enabled and the

information in “OBS-Records.xIs” is correct.

Create a new sheet for the AhsayOBS users. Let’s call it “billing user list” for convenience.
To do this,
a. Right click on the tab of the [Template] worksheet (near the bottom) and click [Move

or Copy].

A dialog box will pop up. Make sure you have chosen the correct workbook (i.e. OBS-
Records.xlIs” and have the [Create a Copy] option checked.

Right-click the tab of the newly created worksheet, click [Rename] and type the name
of the worksheet. By default the name is in the format of ‘MMM-YYYY’, e.g. ‘Jun-
2007’. If you would like to have other format of names, please also modify the values
in the worksheet [Constants] of “OBS-Invoice.xIs”, as mentioned in the Setting up
environment part before.

In the [Constants] worksheet, if the record does not exists on the lists of
“BILL_MONTH_DISPLAY” (Column D) and “BILL_MONTH_WS” (Column E), it is
necessary to add a new record. For example, if you have ‘Jan-2008’ as both the
billing month display and the record worksheet name, add ‘Jan-2008’ to cell D14 and
E14, assuming that D14 and E14 are empty and are the end of the lists. Then the list
would become:

BILL_MONTHS DISPLAY BILL_MONTHS WS
Jan-2007 Jan-2007
Feb-2007 Feb-2007
Mar-2007 Mar-2007
Apr-2007 Apr-2007
May-2007 May-2007
Jun-2007 Jun-2007
Jul-2007 Jul-2007
Aug-2007 Aug-2007
Sep-2007 Sep-2007
Oct-2007 Oct-2007
Nov-2007 Nov-2007
Dec-2007 Dec-2007
Jan-2008 Jan-2008

However, it is recommended to start over a new workbook every single year. Then
you do not have to insert a new record, but replace values of year 2007 with year
2008.

BILL_MONTHS DISPLAY BILL_MONTHS WS
Jan-2008 Jan-2008

Feb-2008 Feb-2008

Mar-2008 Mar-2008

Apr-2008 Apr-2008

May-2008 May-2008

Jun-2008 Jun-2008

Jul-2008 Jul-2008

Aug-2008 Aug-2008

Sep-2008 Sep-2008
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Oct-2008 Oct-2008

Nov-2008 Nov-2008

Dec-2008 Dec-2008

Change the value of Cell Al of the renamed sheet to the specific month in the format of
‘MMM-YYYY’, e.g. 'Jun-2007’. You cannot use other date formats in this cell.

Press the [Refresh] button and a popup will show up. It is the filter of users.

Check the boxes to indicate that the users with that particular option should be included in
the billing list. Uncheck the options if you want to filter the users with these options. For
example, if you are not going to charge the trial users, uncheck the box [Trial] and then
press [Filter]. The trial users will not appear on the list after all. [Registration Date] is a
little bit different from the others. The checkbox indicates if the registration date of the
user fulfills one of the filtering criteria, and the value in the textbox on the right-hand-side
indicates that the registration date should not be later than the given value.

Check [Save as default] if you want to use the current filter as the default filter. The
information will be saved in the worksheet [Default Filter]. Please do not modify the
[Default_Filter] worksheet manually.

Click [OKk] to close the filter and you will then have the list imported automatically.

A message will prompt you the number of new users which are not defined before. The
new uses will be added to the [Users] worksheet directly, without assigning company and
user ID.

Best practice tips: As time goes by, you will have increasing number of worksheets named
‘MMM-YYY’. To keep down file size, please back up the excel file and work on a fresh excel file
(with extra tabs deleted) yearly.

3.2.2 Define companies

To define companies, please follow the procedures below:

1. Open “OBS-Records.xIs”.

2. Open the [Companies] worksheet.

3. Starting from the second row input the information of the company. Please refer to the
section of Company for more details about the fields. The ‘Company ID’ field cannot be left
blank.

3.2.3 Assign users to companies

To assign users to companies, please follow the procedures below:

4.
5.
6.

Open “OBS-Records.xIs”
Open the [Users] worksheet.

Starting from the second row, input the information of the user. Please refer to the section
of User for more details about the fields. The ‘User ID’ field cannot be left blank. After
inputting the ‘Company ID’ for the user, the corresponding company name is displayed. A
drop down box is provided to minimize typos.

3.24 Link billing users to AhsayOBS users

Before linking billing users to AhsayOBS users, make sure you have finished assigning users to
companies and every user has a non-blank user ID.

To link billing users to AhsayOBS users, please follow the procedures below:

1.

2
3.
4

Open “OBS-Records.xIs”
Open the data usage worksheet created before, e.g. [Jun-2007].
Press the [Refresh] button and apply the same filter used in getting AhsayOBS data usage.

If there is no message prompt and there is no blank in the company ID, package ID and
user ID fields, the setting of users is completed. Otherwise, follow the instructions
provided by the message prompt and try it again.
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Defining pricing packages

Before continuing, design your pricing plan after fully understanding the model. This is very important,
because if the logic is wrong, the program will not work and no error will be reported. It will be very
difficult to troubleshoot later on. Please refer to the section of Condition, Condition Group, Pricing and
Package for more details.

If you find that it is difficult to understand the pricing setup, please refer to the Case Studies section,
which shows you some practical examples of pricing packages. You may also go to the Hassle-free
Service section if you do not want to spend time on setting up the packages.

It is recommended to do the following steps sequentially.

331 Define conditions
To define conditions, please follow the procedures below:
1. Open “OBS-Records.xIs”
2. Open the [Conditions] worksheet.
3. Assign an ID for the condition.
4

Choose the field to be compared, the comparator and enter the value to be compared. For
storage and quota, the unit is megabyte (MB) and for bandwidth, the wunit is
kilobits/second (Kb/s).

Please refer to the section of Condition for more details about the fields.

3.3.2 Define condition groups
To define condition groups, please follow the procedures below:
1. Open “OBS-Records.xls”
2. Open the [Condition Groups] worksheet.
3. Assign an ID for the condition group.
4

Select the ‘Condition ID’ of the corresponding conditions. If you want to assign the
conditions to the same group, assign the same ID to the conditions like this:

Condition Group ID Condition ID
ConditionGroupl Condition1
ConditionGroupl Condition2

Please refer to the section of Condition Group for more details about the fields.

3.3.3 Define packages
To define packages, please follow the procedures below:
1. Open “OBS-Records.xls”
2. Open the [Packages] worksheet.
3. Assign an ID for the package.
4

Choose if the package is a group package, and enter the ‘Package Description’ and the
‘Exchange Mailbox Description’.

Please refer to the section of Package for more details about the fields.

3.34 Define pricings
To define pricings, please follow the procedures below:
1. Open “OBS-Records.xls”
2. Open the [Pricings] worksheet.

3. Assign an ID for the pricing. Input the pricing name (optional).
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7.
8.

Select the appropriate ‘Condition Group ID’ and ‘Package ID’. Similar as in [Condition
Groups], if you want to assign different pricing to the same package, assign the same
‘Package ID’ to the pricing like this:

Pricing 1D Pricing Name Package 1D Condition Group 1D
Pricingl My pricing 1 Packagel ConditionGroupl
Pricing2 My pricing 2 Packagel ConditionGroup2

If there are more than one pricing structure in the same package, assign a priority to the
pricing. The larger the number, the higher the priority.

Select the ‘Calculation Unit’, which is the unit to calculate the amount, and then input the
corresponding unit price. If the ‘Calculation Unit’ is fixed, it will not be the unit price but a
fixed price, and a fixed amount should be input under the ‘Price’ column.

Decide if ‘Prorate by Days’ is applicable.

Input the rate for each Exchange mailbox in the ‘Exchange Mailbox Rate’ column.

Please refer to the section of Pricing for more details about the fields.

3.35 Assign packages to companies

To assign packages to companies, please follow the procedures below:

1.
2.
3.

P

Open “OBS-Records.xIs”
Open the [Companies] worksheet.

After entering the details of the companies, you can then assign packages to companies,
by selecting the corresponding ‘Package ID’. Please note that there can only be one
package for each company. The same package can be re-used by other companies. You
may also divide a company in the real world into more than one “companies”, so that the
company in the real world can have two packages, by assigning the packages to the
“companies” in the program.

lease refer to the section of Relationships between Conditions, Condition Groups, Pricings and

Packages for more details.

Customizing bills

Open the

[Bill] worksheet in “OBS-Bill.xIs”. The white part on the left is the default layout of the bill,

where the grey part on the right is for programming use only. You MUST keep the “OBS-Records.xIs”
opened when generating bills.

The following instructions are based on the workbook of “OBS-Bill.xlIs” if no workbook is specified.

341 Layout

The layout part is divided into two parts: “Client Information” and “Content”. By default, it is
defined that the area between row 5 and 13 is “Client Information” and the area between 15
and 21 is “Content”.
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In the picture above, the parts highlighted with red are customizable. However, there are some
restrictions. Please read the paragraphs below in details before starting customization.

i. Client Information

Most of the client information will be generated automatically by the use of Excel
formula. If any information appears to be wrong in the bill, please do not modify it
directly in the bill. For example, if the company name is wrong in the bill, change the
company name in the worksheet [Companies] of “OBS-Records.xIs”, instead of the bill
itself.

The only information required to input is the ‘Bill Month’ and the ‘Company ID’ because
it is necessary to choose which usage month to be billed and the company to be billed,
in order to generate a ‘Bill’.

When you change the ‘Company ID’ or the ‘Bill Month’, the bill will be refreshed and will
re-generate all information again. To change the ‘Bill Month’ and ‘Company ID’, select
the appropriate value from the drop-down box. There are some functions that can loop
through all companies and it is not necessary to choose which company to be billed
every time.

In the client information part, you may change the colors, font styles, words, and layout
of the bill, but please do NOT change the positions of fields. You can only change the
positions of ‘Company Name’, ‘Address’, ‘Country’ and ‘Phone’. If you want to insert
some information between the end of “Client Information” and the title of contents (i.e.
before or after row 14), you must also modify the value in the 113 cell, which indicates
the starting row of contents. Please refer to the Programming section for more details.

ii. Content

The content portion is the area for rows of records which are to be billed, provided with
corresponding ‘Bill Month’ and ‘Company ID’. Please refer to the section of Client
Information about how to select the ‘Bill Month’ and ‘Company ID’.

You must not change any position or delete any rows in the content area. It is fully
controlled by the programming code. If there is any change in position, the whole
program will be corrupted.

However, it is possible to change the color or font style of the titles, i.e. cells A15 to F15
by default.
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3.4.2

3.4.3

It you have inserted any row before the content portion, so that the content portion
starts on a lower row, you will have to change the ‘Starting Row’ in the ‘Input Area’ of
the programming part. Please refer to the Programming section for more details.

Programming

All fields in the programming part must not be modified, except the values in the ‘Input Area’,
which is colored in cyan.

$0
16

In the ‘Input Area’, you can enter an amount of special discount for the client. Words will
appear on the last row of content when the value is not zero.

The second field for input is the ‘Starting Row’. It indicates that the program will start writing
records on that row. By default the value is 16. Make sure you have this value correct,
otherwise the whole layout of the bill will be corrupted.

Others

You may change the page setup. By default, the page size is A4 and the print area is fixed to
the bill page. To change the setup, choose [File] in the menu and select [Page Setup]. You can
change the [Paper Size] on the [Page] page and the [Print Area] on the [Sheet] page.

It is advised to check the billing amount if it is your first time using this program. Conditions,
condition groups, pricing and packages may be defined improperly, thus leading to
miscalculation of the billing amount.

Generating and emailing bills

Generating and emailing bills are all done in the workbook of “OBS-Bill.xIs”. The following instructions
are based on the workbook of “OBS-Bill.xIs” if no workbook is specified.

You must generate bills before sending emails.

3.5.1

3.5.2

Generate bills

After all the customizations are done, and the billing fees are checked to be correct, you can
generate a PDF bill by clicking on the [Generate] button.

The generated PDF files can be found under the “PDF” folder by default. Inside the “PDF”
folder, you will find subfolders named with the current month (not billing month). For example,
if you click the [Generate] button in June 2007, then the PDF file will be saved in a subfolder
named “2007-06". The PDF folder name can be maodified in the [Constants] worksheet of “OBS-
Bill.xIs” without modifying the code.

The file name will be a combination of the company ID and the bill month. For example, if the
company name is MyCompany and the bill month is ‘Jun-2007’, the file name will be
“MyCompany_Jun-2007.pdf”. You will need to change the code if you want to modify these
settings, and it is not recommended.

Clicking the [Generate All] button will generate all the PDF files for every company you have
entered in “OBS-Records.xIs”. However bills with a zero or negative amount will be ignored and
will not be generated. Also, companies with ‘FALSE’ in the charge column will be ignored
(please refer to section Company for more information).

Email bills
After generating PDF bills, it is ready to be sent to clients.

Before clicking on the [Send Email] button, it is important to customize your email content
first. The email content is stored in the [Email] worksheet. You can customize the ‘From’, ‘Cc’
‘Bee’, ‘Subject’ and ‘Content’. Emails will be sent based on these fields with the PDF file
attached.

For the fields ‘Cc’ and ‘Bcc’, you can add more email addresses if necessary, by separating
them with commas (“,”). For example, if you want to Cc to more then one email address,
simply just input something like emaill@mycompany.com, email2@mycompany.com.
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Please note that only plain-text content is supported. You may try other formats, but if there is
any error caused, it will not be treated as a bug and it is not going to be fixed.

After modifying the email contents, you can then send an email to the client by clicking on the
[Send Email] button. A dialog box will pop up for your confirmation.

If you have not generated the PDF file, there will be an error message and the email will not be
sent. Also, make sure you have configured your mail server settings correctly. The settings are
placed in the [Constants] worksheet of “OBS-Bill.xIs”. Please refer to section Setting up the
environment for more information. It is advised to send an email to a testing email address in
order to spot any mistakes before mass broadcast.

Similar to generating bills, by clicking on [Send All Emails], emails with bills attached will be
sent to every company you have entered in “OBS-Records.xIs” with a positive billing amount
for the month. The destination email address follows the email shown on the bill. It is advised
to check if the value is correct before sending.

Bills with zero or negative amount, or companies with ‘FALSE’ in the charge column (please
refer to section Company for more information) will be ignored and will not be sent.

Billing Records Tracking

When a bill is generated, the worksheet of [Billing Records] would also be updated. If it is a new bill, a
new record will be generated; otherwise, the bill record will be updated. The program determines if it is
a new bill by comparing the ‘Bill Month’ and ‘Company ID” on the bill and on the [Billing Records].

You can use the auto-filter function to view the records of specific months or specific companies. In
order to use the auto-filters, just simply click on the title of each column (e.g. ‘Bill Month’), and select
the corresponding value. You can also write a custom filter by choosing [(Custom)] as the value. The
total will be calculated automatically whenever the filter is changed.

The ‘Paid’ column (in green) provides easy tracking of billing records. It is very convenient to filter paid
and unpaid records by using auto-filters. This column should be maintained manually and by default it is
set to false.

Hassle-free Service

We understand that setting up the environment, defining items and customizing the bill spend a lot of
time and effort. Especially for defining the pricing plan, it is not easy to analyze the pricing logic and put
it into the program.

As Ahsay always do, we also provide services to try our best to help our partners. If you find it is too
hard or there is not enough time to do the setup, you may try our Hassel-free service on billing. By
using this service, we will do all the setup, defining and customizing issues, with the information
provided by you.

If you are interested in this service, please contact us via our forum .
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Case Studies

The following case studies show you examples on how to setup your pricing plan in practical use. They are
already delivered as examples with the billing program. You are welcome to use them directly if your
pricing plan is similar to them. Each case study is divided into 6 parts:

6.

1
2
3.
4
5

Definition
Conditions
Condition Groups
Packages

Pricings

Assigning Packages to Companies

In order to fit to the document, tables and the billing templates are not necessarily in the same scale of

those in the billing program.

Please be reminded that the user filter will filter out users to be charged, which may cause the missing of
charges.

i. Definition

Case 1 — Bill with pricing based on storage and client type

IT Company A is a service provider of online backup. It charges users by the scale of storage.

Storage OBM Unit Price ACB Unit Price Exchange Mailbox Unit Price
9 (US$/MB) (US$/MB) (US$/Mailbox)
<10M 10 8 0.5
<100M 9 7 0.5
<1G 8 6 0.5
<10G 7 5 0.5
>=10G 5 4 0.5

The table above shows the logics of its pricing plan. When the users has storage less then 10MB,
the unit price for each MB will be US$10. When the users use more, they can enjoy lower price.
The price will be $5 if the user uses more than 10GB. ACB Users enjoy lower charges than OBM
users. Additional Exchange Mailbox will be charged with a constant rate.

ii. Conditions

To setup a pricing plan like this in the billing program, Mr. Smith, IT manager of IT Company A,
has created conditions in the [Conditions] worksheet as follows:

Condition 1D Field Name Comparator Value Notes
C_MTS_L10M Max Total Storage < 10 <10M
C_MTS_L100M Max Total Storage < 100 <100M
C_MTS_L1G Max Total Storage < 1024 <1G
C_MTS_L10G Max Total Storage < 10240 <10G
C_MTS_GE10G Max Total Storage >= 10240 >=10G
C_CT_EOBM Client Type = “OBM” OBM Users
C_CT_EACB Client Type = “ACB” ACB Users

iii. Condition Groups

From the logic of the pricing plan, in order to obtain a price, both conditions for storage and for
client type must be obtained. In order to join the conditions, Mr. Smith has created groups in the
[Condition Groups] worksheet as followings:
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Condition Group ID Condition ID Notes
CG_MTS_L10M_CT_EOBM C_MTS_L10M <10M
CG_MTS_L10M_CT_EOBM C_CT_EOBM OBM Users
CG_MTS_L100M_CT_EOBM C_MTS_L100M <100M
CG_MTS_L100M_CT_EOBM C_CT_EOBM OBM Users
CG_MTS_L1G_CT_EOBM C_MTS_L1G <1G
CG_MTS_L1G_CT_EOBM C_CT_EOBM OBM Users
CG_MTS_L10G_CT_EOBM C_MTS_L10G <10G
CG_MTS_L10G_CT_EOBM C_CT_EOBM OBM Users
CG_MTS_GE10G_CT_EOBM C_MTS_GE10G >=10G
CG_MTS_GE10G_CT_EOBM C_CT_EOBM OBM Users
CG_MTS_L10M_CT_EACB C_MTS_L10M <10M
CG_MTS_L10M_CT_EACB C_CT_EACB ACB Users
CG_MTS_L100M_CT_EACB C_MTS_L100M <100M
CG_MTS_L100M_CT_EACB C_CT_EACB ACB Users
CG_MTS_L1G_CT_EACB C_MTS_L1G <1G
CG_MTS_L1G_CT_EACB C_CT_EACB ACB Users
CG_MTS_L10G_CT_EACB C_MTS_L10G <10G
CG_MTS_L10G_CT_EACB C_CT_EACB ACB Users
CG_MTS_GE10G_CT_EACB C_MTS_GE10G >=10G
CG_MTS_GE10G_CT_EACB C_CT_EACB ACB Users

Therefore, there are totally 10 condition groups, and each of them represents each pricing case:
ConditionGroupl = OBM users with storage less than 10MB
ConditionGroup2 = OBM users with storage less than 100MB

ConditionGroup3 = OBM users with storage less than 1GB

ConditionGroup9 = ACB users with storage less than 10G
ConditionGroup10 = ACB users with storage more than or equal to 10G

Note: the color is used for better readability only, and has no special meaning.

iv. Packages

In this case, IT Company A has only 1 pricing plan and therefore 1 package only. Mr. Smith has
created the package in the [Packages] worksheet like the following:

Package 1D Group Package Package Description
Storagel FALSE IT Company A Standard Storage Package
v. Pricings

After creating the packages, Mr. Smith can now merge the data together and create the pricing
plan. In the [Pricings] worksheet, Mr. Smith has created pricings as following:
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L " Exchange
Pricing ID | Fricing Rackaos Condition Group 1D Priority Callauliziien Price [HIEEE B Mailbox
Description 1D Unit by days Mailbox Rate X
Description

) . Max Total Exchange Mailbox

Pricing1 <10 M Pricing Storagel CG_MTS_L10M_CT_EOBM 10 Storage 10 FALSE 05 | Charges
Pricing2 <100M Pricing Storagel CG_MTS_L100M_CT_EOBM 9 Max Total 9 FALSE 05 Exchange Mailbox

Storage Charges
) A Max Total Exchange Mailbox

Pricing3 <16 Pricing Storagel CG_MTS_L1G_CT_EOBM 8 Storage 8 FALSE 05 | Charges
) . Max Total Exchange Mailbox

Pricing4 <106 Pricing Storagel CG_MTS_L10G_CT_EOBM 7 Storage 7 FALSE 05 | Charges
Pricing5 >=10G Pricing Storagel CG_MTS_GE10G_CT_EOBM 6 Max Total 5 FALSE 05 Exchange Mailbox

Storage Charges
<10M Pricing Max Total Exchange Mailbox

Pricing6 prvsis Storagel CG_MTS_L10M_CT_EACE 5 Storage 8 FALSE 05 | Crarges
<100M Pricing Max Total Exchange Mailbox

Pricing7 AGB) Storagel CG_MTS_L100M_CT_EACB 4 torage 7 FALSE 05 | Groraos
) <16 Pricing Max Total Exchange Mailbox

Pricing8 Prv Storagel CG_MTS_L1G_CT_EACB 3 Storage 6 FALSE 05 | Craraes
<106 Pricing Max Total Exchange Mailbox

Pricing® prvse Storagel CG_MTS_L10G_CT_EACB 2 Storage 5 FALSE 05 | Crarges
>=10G Pricing Max Total Exchange Mailbox

Pricing10 B Storagel CG_MTS_GE10G_CT_EACB 1 torage 4 FALSE 05 | Groracs

‘Pricingl’ has the highest priority, so that if the ‘Max Total Storage’ is less than 10M and the ‘User
Type’ is ‘PAID’, the program will stop searching and treat ‘Pricingl’ as the applicable pricing
scheme that will be used to charge for the month.

vi. Assighing Packages to Companies

In the [Companies] worksheet, IT Company A has only one package, and therefore Mr. Smith
entered ‘Storagel’ in the ‘Package ID’ field for all their clients (companies).

It is then all done and Mr. Smith will be able to use the billing program with his own plan. A
sample bill is given below:
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Taur
Ornpany
LEogo

Online Backup Service Bill

My Company Limited
Website: www.website.com
Email: admin@email.com
Fax: 12345678910

Company Information ‘

Bill Date
21-Aug-2007

Bill Month: Jun-2007

Company ID: C-000-001

Company Name: IT Company A Clientl

Address : addressl Total Due

Country : us $51,157.81

Phone: 9876-5432

Email: myemail@companyA.com

No. Pricing ID Description Price Qty Total (USD)
1 Pricing4 [Betty] <10G Pricing 7 5440.4 38,082.83
2 Pricing8 [Cathy] <1G Pricing (ACB) 6 828.622 4,971.73
3 Pricing4 [David] <10G Pricing 7 1154.79 8,083.56
4 Pricingl [Eddie] <10 M Pricing 10 0.60371 6.04
5 Pricingl [Eddie] Exchange Mailbox Charges 0.5 5 2.50
6 Pricing6 [Frank] <10M Pricing (ACB) 8 1.39343 11.15

Thank you for using Online Backup!

m $51,157.81

In the user list generated by [Jun-2007], ‘Cathy’ and ‘Frank” are ACB users and only ‘Eddie’ has
been assigned with Exchange Mailbox in the whole IT Company A Clientl. Another user ‘Adam’

has not used the service, and so his record is ignored.

Case 2 — Bill with pricing based on storage, subscribed modules, client

application type and user type.

This is an example to charge according to the usage/storage and charge OBM/ACB by unit. Please

ensure that you are using the latest version of billing module.

i. Definition

IT Company E is a service provider of online backup. It charges clients by the scale of storage,

used OBM/ACB CAL, Exchange Brick level, V-Sphere and VMWare unit.

User Storage Exch?_r;g\;/ngrlck N(')S"_ :/ll_\/lsvp\’lg?;e ACB Client OBM Client
Type (US$/GB) (US$/mailbox) (US$/unit) (US$/client) (US$/client)
Reseller 0.5 0.5 1.5 1.5 1.5
End 1.1 1.0 7.5 2.0 2.5
Users
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Example 1: If a reseller subscribed 10 GB of storage, 20 Exchange mailboxes, 2 units of Microsoft
V-Sphere and 3 units of VMware with OBM. The monthly charge will be

Total amount = Storage + Mailbox+ V-Sphere + VMWare + OBM
= (0.5 x 10) + (0.5 x 20) + (2 x 1.5) + (3 x 1.5) + 1.5

=5+10+3+45+ 15

=24

Example 2: If an end user subscribed 20 GB of storage, 10 Exchange mailboxes, 3 units of
VMware, 3 OBM and 1 ACB. The monthly charge will be

Total amount = Storage + Mailbox+ VMWare + OBM + ACB
= (1.1 x 20) + (1.0 x 10) + (3 x 7.5) + (3 x 2.5) + 2.0
=22+10+225+75+ 2

=64

ii. Conditions

To setup a pricing plan like this in the billing program, the development team of IT Company E
has created conditions in the [Conditions] worksheet as follows:

Condition ID Field Name Comparator | Value Notes

C_CT_EOBM Client Type = “OBM” OBM Users

C_CT_EACB Client Type = “ACB” ACB Users
iii. Condition Groups

Plenty of Condition Groups are necessary to fulfill the requirement:

Condition Group ID Condition 1D Notes

CG_MTS_CT_EOBM C_CT_EOBM OBM Users

CG_MTS_CT_EACB C_CT_EACB ACB Users

iv. Packages

In this case, IT Company E has two pricing plans. The

package in the [Packages] worksheet like the following:

development team has created the

Package 1D Group Package Package Description

User FALSE User Package

Reseller FALSE Reseller Package
Pricings
Now, the development team can merge the data together and create the pricing plan. In the
[Pricings] worksheet, the development team has created pricings as follows:

Pricing 1D gl:(s:(i:?g)tion Package ID Condition Group ID Priority Calculation Unit Price g;c;lrsate by

ResellerOBM Reseller Pricing OBM Reseller CG_MTS_CT_EOBM 2 Max Total Storage 0.5 FALSE
ResellerACB Reseller Pricing ACB Reseller CG_MTS_CT_EACB 1 Max Total Storage 0.5 FALSE
OBM Storage Pricing OBM User CG_MTS_CT_EOBM 2 Max Total Storage 1.1 FALSE
ACB Storage Pricing ACB User CG_MTS_CT_EACB 1 Max Total Storage 1.1 FALSE
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. - Additional
. Rate Description Virtualization L Charge
Rate Description Description Charge .
Description
Exchange Ms Win OBM
0.5 °hang 15 VMWare Charges 1.5 | server 15 Software
Mailbox Charges L
Virtualization Charge
ACB Software
1.5 Charge
Exchange Ms Win OBM
1.0 °hang 75 VMWare Charges 7.5 | Server 25 Software
Mailbox Charges L
Virtualization Charge
ACB Software
2.0 Charge

Since the work sheet is too long, the work sheet is broken into 2 tables. Some of the
description/charges are not applied as ACB does not come with those modules.

vi. Assignhing Packages to Companies

In the [Companies] worksheet, the development team entered ‘Reseller’ and ‘Standard’ in the
‘Package ID’ field for all their clients (companies).

It is then all done and the development team will be able to use the billing program with their
own plan. A sample bill is given below:
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“rour
Cornpany
Logo

Online Backup Service Bill

My Company Limited
Website: www.website.com
Email: admin@email.com
Fax: 12345678910

Company Information

Bill Date
21-Aug-2013

Thank you for using Online Backup!

Bill Month: Jun-2013

Company ID: C-000-002

Company Name: Reseller Company

Address : address2 Total Due

Country : us $35.14

Phone: 9876-5433

Email: myemail@companyB.com

No.  Pricing ID Description Price Qty Total (USD)
1 ResellerOBM [George] Reseller Storage Pricing 0.5 1.37985 0.69
2 ResellerOBM [George] Exchange Mailbox Charges 0.5 5 2.50
3 ResellerOBM [George] OBM Software Charge 15 1 1.50
4 ResellerOBM [Helen] Exchange Mailbox Charges 0.5 5 2.50
5 ResellerOBM [Helen] OBM Software Charge 15 1 1.50
6 ResellerOBM [Iris] Reseller Storage Pricing 0.5 1.37985 0.69
7 ResellerOBM [Iris] Exchange Mailbox Charges 0.5 5 2.50
8 ResellerOBM [Iris] OBM Software Charge 15 1 1.50
9 ResellerOBM [Joe] Reseller Storage Pricing 0.5 0.14841 0.07
10 ResellerOBM [Joe] Exchange Mailbox Charges 0.5 5 2.50
11 ResellerOBM [Joe] OBM Software Charge 15 1 1.50
12 ResellerOBM [Ken] Exchange Mailbox Charges 0.5 5 2.50
13 ResellerOBM [Ken] OBM Software Charge 15 1 1.50
14 ResellerOBM [Linda] Reseller Storage Pricing 0.5 1.37985 0.69
15 ResellerOBM [Linda] Exchange Mailbox Charges 0.5 5 2.50
16 ResellerOBM [Linda] OBM Software Charge 15 1 1.50
17 ResellerOBM [Mary] Reseller Storage Pricing 0.5 0.60371 0.30
18 ResellerOBM [Mary] Exchange Mailbox Charges 0.5 5 2.50
19 ResellerOBM [Mary] OBM Software Charge 15 1 1.50
20 ResellerOBM [Nancy] Reseller Storage Pricing 0.5 1.37985 0.69
21 ResellerOBM [Nancy] Exchange Mailbox Charges 0.5 5 2.50
22 ResellerOBM [Nancy] OBM Software Charge 15 1 1.50

-EE- $35.14

Case 3 — Bill on subscription of bandwidth plans with prorating option

i. Definition
IT Company B is a service provider of online backup. It charges users by different bandwidth
limits.
Bandwidth Monthly Fee (US$) Prorate by Days
1Mb/s 20 No
5Mb/s 30 No
Unlimited 50 Yes

The table indicates that if the user has joined the 1Mb/s plan, the monthly fee for the user is
fixed to US$20. The same logic applies to 5Mb/s and unlimited bandwidth plans. “Prorate by
days” is enabled only for unlimited bandwidth plan, so that the client with unlimited bandwidth
plan can enjoy the discount if their usage period is less than a month.
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For some reasons, SpecialClient, a client of IT Company B, is allowed to enjoy a special plan, with
US$40 only for the unlimited bandwidth, but there is no proration by days.

ii. Conditions

To setup a pricing plan like this in the billing program, Kenny, IT manager of IT Company B, has
created conditions in the [Conditions] worksheet as follows:

Condition ID Field Name Comparator Value Notes
C_BW_E1M Bandwidth = 1024 1Mb bw
C_BW_E5M Bandwidth = 5120 5Mb bw
C_BW_EU Bandwidth = 0 Unlimited bw

iii. Condition Groups

As one condition is very enough to achieve the correct price, each condition group contains only

one condition.

Condition Group ID Condition ID Notes
CG_BW_E1M C_BW_E1M 1Mb bandwidth
CG_BW_E5M C_BW_E5M 5Mb bandwidth
CG_BW_EU C_BW_EU Unlimited bandwidth
CG_BW_EU_S C_BW_EU Special bandwidth
iv. Packages
In this case, IT Company B has totally 2 pricing plans: one for normal client and one for
SpecialClient. Kenny has created 2 packages in the [Packages] worksheet like the following:
Package 1D Group Package Package Description
Bandwidthl FALSE Normal Bandwidth Package
BandwidthSC FALSE SpecialClient Bandwidth Package
v. Pricings
Now, Kenny can merge the data together and create the pricing plan. In the [Pricings]
worksheet, Kenny has created pricings as following:
. Pricing Condition i Calculation . Prorate
Pricing ID NEm® Package ID Group ID Priority Unit Price by Days
1Mb . )
NormalP1 . Bandwidth1 CG_BW_E1M 1 Fixed 20 FALSE
Bandwidth - =
NormalP2 SMb . Bandwidth1 CG_BW_E5M 2 Fixed 30 FALSE
Bandwidth - =
NormalP3 Unlimited Bandwidth1 CG_BW_EU 3 Fixed 50 TRUE
Bandwidth
scP sfiggia' BandwidthSC | CG_BW_EU_S 4 Fixed 40 | FALSE
vi. Assigning Packages to Companies

In the [Companies] worksheet, Kenny entered ‘Bandwidthl’ in the ‘Package ID’ field for all their
clients (companies), except for SpecialClient. He has entered ‘PackSC’ in the ‘Package ID’ field for

SpecialClient.

It is then all done and Kenny will be able to use the billing program with his own plan. A sample

bill is given below:
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Taur
Ornpany
LEogo

Online Backup Service Bill

My Company Limited
Website: www.website.com
Email: admin@email.com
Fax: 12345678910

Company Information ‘

Bill Date
21-Aug-2007

Bill Month: Jun-2007
Company ID: C-000-002
Company Name: IT Company B Clientl
Address : Address2 Total Due
Country : us $365.00
Phone: 9876-5433
Email: myemail@companyB.com
No. Pricing ID Description Price Qty Total (USD)
1 NormalP3 [George] Unlimited Bandwidth, 21 Days Only 50 1 35.00
2 NormalP3 [Helen] Unlimited Bandwidth 50 1 50.00
3 NormalP3 [Iris] 5Mb Bandwidth 30 1 30.00
4 NormalP3 [Joe] Unlimited Bandwidth 50 1 50.00
5 NormalP3 [Ken] Unlimited Bandwidth 50 1 50.00
6 NormalP3 [Linda] Unlimited Bandwidth 50 1 50.00
7 NormalP3 [Mary] Unlimited Bandwidth 50 1 50.00
8 NormalP3 [Nancy] Unlimited Bandwidth 50 1 50.00

Thank you for using Online Backup!

.a!l. $365.00

In the user list generated by [Jun-2007], ‘Iris’ is using 5Mb/s bandwidth where others are using
unlimited bandwidth. ‘George’ has joined the plan on 10-Jun-2007, and therefore he receives

proration of 50 * (30-10+1)/30.

Similarly, for the company SpecialClient, each user in the company will be charged for US$40:
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Tour

Zarnpany

L |:| g |:| _My Company _Limited
Website: www.website.com

Email: admin@email.com
Fax: 12345678910

Online Backup Service Bill

Company Information ‘ Bill Date
Bill Month: Jun-2007 21-Aug-2007

Company ID: C-000-003
Company Name: SpecialClient
Address : Address3 Total Due
Country : us $120.00
Phone: 9876-5434
Email: myemail@specialclient.com
No. Pricing ID Description Price Qty Total (USD)

1 SCP [Oscar] Special Pricing for SpecialClient 40 1 40.00

2 SCP [Paul] Special Pricing for SpecialClient 40 1 40.00

3 SCP [Quinn] Special Pricing for SpecialClient 40 1 40.00

.a!l. $120.00

Thank you for using Online Backup!

4.4  Case 4 — Bill with pricing based on uploaded file size and group packages

i. Definition
IT Company C is a service provider of online backup. It charges clients by the total uploaded
storage size of the whole company.

Uploaded Size Unit Price
Less than 10GB US$ 0.01 per MB
10~100GB (excluding) US$ 0.008 per MB
100GB~1TB (excluding) US$ 0.005 per MB
Equal or above 1TB US$ 1000.00

The table indicates that if the total uploaded file size of all the users in the company in that
month is less than 10GB, the price for each 1 MB storage will be US$0.01. Similar logic applies to
size >=10GB and >=100GB. If the company uploaded size exceeds 1TB (1000GB), the billing fee
will be fixed at US$1000.

ii. Conditions

To setup a pricing plan like this in the billing program, Ms. Anderson, IT manager of IT Company
C, has created conditions in the [Conditions] worksheet as follows:
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Condition ID Field Name Comparator Value Notes
C_TUS_L10G Total Uploaded Size < 10240 <10GB
C_TUS_GE10G Total Uploaded Size >= 10240 >=10GB
C_TUS_GE100G Total Uploaded Size >= 102400 >=100GB
C_TUS_GE1T Total Uploaded Size >= 1048576 >=1TB

iii. Condition Groups

As one condition is sufficient to achieve the correct price, each condition group contains only one

condition.
Condition Group ID Condition ID Notes
CG_TUS_L10G C_TUS_L10G 10GB
CG_TUS_GE10G C_TUS_GE10G >=10GB
CG_TUS_GE100G C_TUS_GE100G >=100GB
CG_TUS_GEAT C_TUS_GE1T >=1TB

iv. Packages

In this case, IT Company C has only one pricing plan and therefore only one package. Ms.
Anderson has created the package in the [Packages] worksheet like the following:

Package ID

Group

Package

Package Description

UploadedSize

TRUE

General Total Uploaded Size Package

v. Pricings

Now, Ms. Anderson can merge the data together and create the pricing plan. In the [Pricings]
worksheet, Ms. Anderson has created pricings as follows:

- Pricing Condition Group A Calculation A Prorate
Pricing ID Description Package ID D Priority Unit Price by Days
Total
SmallPricing Small Usage UploadedSize CG_TUS_L10G 1 Uploaded 0.01 FALSE
Size
. . Medium . Total
MediumPricing Usage UploadedSize CG_TUS_GE10G 2 Uploaded 0.008 FALSE
Size
Total
LargePricing Large Usage UploadedSize CG_TUS_GE100G 3 Uploaded 0.005 FALSE
Size
Total
VIPPricing VIP UploadedSize CG_TUS_GEAT 4 Uploaded 1000 FALSE
Size

vi. Assigning Packages to Companies

In the [Companies] worksheet, Ms. Anderson entered ‘UploadedSize’ in the ‘Package ID’ field for

all their clients (companies).

It is then all done and Ms. Anderson will be able to use the billing program with her own plan. A

sample bill is given below:
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4.5

Taur
Ornpany
LEogo

Online Backup Service Bill

My Company Limited
Website: www.website.com
Email: admin@email.com
Fax: 12345678910

Company Information

Bill Date
21-Aug-2007

Bill Month: Jun-2007
Company ID: C-000-004
Company Name: IT Company C Clientl
Address : Address4 Total Due
Country : us $91.14
Phone: 9876-5435
Email:
mal myemail@companyC.com
No. Pricing ID Description Price Qty Total (USD)
. . Medium Usage, Users- Rose; Steven, Teresa,;
1 Medium Pricing Uri; Vicky: Wendy: - - 101.14
Special Discount ($10.00)

Thank you for using Online Backup!

m $91.14

In the user list generated by [Jun-2007], there are users ‘Rose’, ‘Steven’, etc. After adding all
their uploaded size, the program calculated the correct total for the whole company. Ms.
Anderson would like to give a discount to this company, and after modifying the “Programming”
part of the bill (refer to the section of Programming for more information), a ‘Special Discount’

row appeared on the bill.

Case 5 — Advanced billing with mixed conditions

This example is rather complex. It is designed for advanced users only. It is recommended to read
through Case 1 to Case 3 before getting into this case.

Definition

IT Company D is a service provider of online backup. It charges clients by the scale of storage,
excluding the size in retention area. Different bandwidth will also affect the price.

Storage Bandwidth Paid User with In-File- Pa_lid User without In- All Trial User
(Mb/s) Delta (US$/MB) File-Delta (US$/MB) (US$/MB)
<1G 10 0.2 0.1 0.01
1~100G 10 0.1 0.05 0.01
>100G 10 0.05 0.02 0.01
<1G Unlimited 0.4 0.2 0.02
1~100G Unlimited 0.2 0.1 0.02
>100G Unlimited 0.1 0.05 0.02

The table indicates that if the total uploaded file size of all the users in the company in that
month is less than 1GB and the bandwidth is 10Mb/s, the price for each MB will be US$0.2. If the
total uploaded file size of all the users in the company in that month is less than 1GB and the
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bandwidth is unlimited, the price for each MB of storage will be US$0.4. Similar logic applies to
size >=1GB and >100GB. Special prices are arranged for trial users.

ii. Conditions

To setup a pricing plan like this in the billing program, the development team of IT Company D

has created conditions in the [Conditions] worksheet as follows:

Condition ID Field Name Comparator | Value Notes
C_MDS_L1G Max Data Size < 1024 <1GB Storage
C_MDS_GE1G Max Data Size >= 1024 >=1GB Storage
C_MDS_G100G Max Data Size > 102400 >=100GB Storage
C_BW_E10M Bandwidth = 10240 10Mb/s Bandwidth
C_BW_EU2 Bandwidth = 0 Unlimited Bandwidth
C_IFD_ET Enabled In-File-Delta = TRUE With In-File-Delta
C_IFD_EF Enabled In-File-Delta = FALSE Without In-File-Delta
C_UT_P User Type <> “TRIAL” Paid Users
C UT_T User Type = “TRIAL” Trial Users

iii. Condition Groups

Plenty of Condition Groups are necessary to fulfill the requirement:

Condition Group ID Condition 1D Notes

CG_SL1G_B10M_IFDF_P C_MDS_L1G <1GB Storage
CG_SL1G_B10M_IFDF_P C_BW_E10M 10Mb/s Bandwidth
CG_SL1G_B10M_IFDF_P C_IFD_EF Without In-File-Delta
CG_SL1G_B10M_IFDF_P C_UT P Paid User

CG_SL1G_BU_IFDF_P C_MDS_L1G <1GB Storage
CG_SL1G_BU_IFDF_P C_BW_EU2 Unlimited Bandwidth
CG_SL1G_BU_IFDF_P C_IFD_EF Without In-File-Delta
CG_SL1G_BU_IFDF_P C_UT P Paid User
CG_SGE1G_B10_IFDT_P C_MDS_GE1G >=1GB Storage
CG_SGE1G_B10_IFDT_P C_BW_E10M 10Mb/s Bandwidth
CG_SGE1G_B10_IFDT_P C_IFD_ET With In-File-Delta
CG_SGE1G_B10_IFDT_P C_UT P Paid User
CG_SGE1G_B10_IFDF_P C_MDS_GE1G >=1GB Storage
CG_SGE1G_B10_IFDF_P C_BW_E10M 10Mb/s Bandwidth
CG_SGE1G_B10_IFDF_P C_IFD_EF Without In-File-Delta
CG_SGE1G_B10_IFDF_P C_UT_P Paid User
CG_SGE1G_BU_IFDT_P C_MDS_GE1G >=1GB Storage
CG_SGE1G_BU_IFDT_P C_BW_EU2 Unlimited Bandwidth
CG_SGE1G_BU_IFDT_P C_IFD_ET With In-File-Delta
CG_SGE1G_BU_IFDT_P C_UT_P Paid User
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CG_SGE1G_BU_IFDF_P C_MDS_GE1G >=1GB Storage
CG_SGE1G_BU_IFDF_P C_BW_EU2 Unlimited Bandwidth
CG_SGE1G_BU_IFDF_P C_IFD_EF Without In-File-Delta
CG_SGE1G_BU_IFDF_P C_UT P Paid User

CG_SG100G_B10_IFDT_P

C_MDS_G100G

>100GB Storage

CG_BU_T

C_BW_EU

CG_SG100G_B10_IFDT_P C_BW_E10M 10Mb/s Bandwidth
CG_SG100G_B10_IFDT_P C_IFD_ET With In-File-Delta
CG_SG100G_B10_IFDT_P C_UT_P Paid User
CG_SG100G_B10_IFDF_P C_MDS_G100G >100GB Storage
CG_SG100G_B10_IFDF_P C_BW_E10M 10Mb/s Bandwidth
CG_SG100G_B10_IFDF_P C_IFD_EF Without In-File-Delta
CG_SG100G_B10_IFDF_P C_UT_P Paid User
CG_SG100G_BU_IFDT_P C_MDS_G100G >100GB Storage
CG_SG100G_BU_IFDT_P C_BW_EU2 Unlimited Bandwidth
CG_SG100G_BU_IFDT_P C_IFD_ET With In-File-Delta
CG_SG100G_BU_IFDT_P C_UT_P Paid User
CG_SG100G_BU_IFDF_P C_MDS_G100G >100GB Storage
CG_SG100G_BU_IFDF_P C_BW_EU2 Unlimited Bandwidth
CG_SG100G_BU_IFDF_P C_IFD_EF Without In-File-Delta
CG_SG100G_BU_IFDF_P C_UT_P Paid User

Unlimited Bandwidth

CG_BU_T

CuUTT

Trial User

The colors and borders are for better readability only, i.e., they have no special meaning.

iv. Packages

In this case, IT Company D has only one pricing plan and therefore only one package. The
development team has created the package in the [Packages] worksheet like the following:

Package 1D Group Package Package Description
Complex01 FALSE Combined and Complex Package
v. Pricings

Now, the development team can merge the data together and create the pricing plan. In the
[Pricings] worksheet, the development team has created pricings as follows:

Pricing
Description

Pricing 1D

Package ID

Condition Group ID

Priority Calculation Unit Price

Prorate by
Days

1~10GB Storage,

PRICE005 10Mb/s Bandwidth, Complex01 CG_SGE1G_B10_IFDT_P 5 Max Data Size 0.1 FALSE
In-File-Delta
1~10GB Storage,

PRICEO06 Storage, 10Mb/s Complex01 CG_SGE1G_B10_IFDF_P 6 Max Data Size 0.05 FALSE
Bandwidth
1~10GB Storage,

PRICEOO7 Storage, Unlimited Complex01 CG_SGE1G_BU_IFDT_P 7 Max Data Size 0.2 FALSE
Bandwidth, In-File-
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Delta

1~10GB Storage,
PRICEOO8 Storage, Unlimited Complex01 CG_SGE1G_BU_IFDF_P 8 Max Data Size 0.1 FALSE
Bandwidth

Trial User, 10Mb/s

PRICEO13 Bandwidth

Complex01 CG_B10_T 13 Max Data Size 0.02 FALSE

Trial User, Unlimited

PRICEO14 Bandwidth

Complex01 CG_BU_T 14 Max Data Size 0.01 FALSE

The colors are for better readability only, i.e., they have no special meaning.

vi. Assigning Packages to Companies

In the [Companies] worksheet, the development team entered ‘Complex01’ in the ‘Package ID’
field for all their clients (companies).

It is then all done and the development team will be able to use the billing program with their
own plan. A sample bill is given below:
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ogo . . . il: admin i
= Online Backup Service Bill e e 15545478010
Bill Date
Bill Month: Jun-2007 21-Aug-2007
Company ID: C-000-005
Company Name: IT Company D Clientl
Address : Address5 Total Due
Country : us $20897.30
Phone: 9876-5436
Email: myemail@companyD.com
No.  Pricing ID Description Price Qty Total (USD)
1 PRICE004 [Yuki] <1GB Storage, Unlimited Bandwidth 0.2 0.14848 0.03
2 PRICEO004 [Zoe] <1GB Storage, Unlimited Bandwidth 0.2 1.71532 0.34
3 PRICE004 [Andy] <1GB Storage, Unlimited Bandwidth 0.2 1.37985 0.28
4 PRICE004 [Ben] <1GB Storage, Unlimited Bandwidth 0.2 1.71529 0.34
5 PRICE008 [Doris] 1~10GB Storage, Storage, Unlimited 0.1 91262.3 9,126.23
Bandwidth
6 PRICE008 [Gloria] 1~10GB Storage, Storage, Unlimited 0.1 2009.89 200.99
Bandwidth
7 PRICE004 [Ilvy] <1GB Storage, Unlimited Bandwidth 0.2 490.148 98.03
8 PRICE008 [Jennifer] 1~10GB Storage, Storage, 0.1 12526.9 1,252.69
Unlimited Bandwidth
9 PRICE004 [Kevin] <1GB Storage, Unlimited Bandwidth 0.2 28.399 5.68
10 PRICE004 [Leo] <1GB Storage, Unlimited Bandwidth 0.2 85.4762 17.10
11 PRICE004 [Michael] <1GB Storage, Unlimited Bandwidth 0.2 164.355 32.87
12 PRICE008 [Nicole] 1~10GB Storage, Storage, Unlimited 0.1 2788.97 278.90
Bandwidth
13 PRICE008 [Ole] 1~10GB Storage, Storage, Unlimited 0.1 3113.06 311.31
Bandwidth
14 PRICE002 [Peter] <1GB Storage, 10Mb/s Bandwidth 0.1 2.71339 0.27
15 PRICE002 [Quartus ] <1GB Storage, 10Mb/s Bandwidth 0.1 251.393 25.14
16 PRICE006 [Richard] 1~10GB Storage, Storage, 10Mb/s 0.05 3705.27 185.26
Bandwidth
17 PRICEO006 [Sam] 1~10GB Storage, Storage, 10Mb/s 0.05 2178.3 108.92
Bandwidth
18 PRICE008 [Tim] 1~10GB Storage, Storage, Unlimited 0.1 12916.4 1,291.64
Bandwidth
19 PRICE008 [Umar] 1~10GB Storage, Storage, Unlimited 0.1 59856.2 5,985.62
Bandwidth
20 PRICE008 [Victor] 1~10GB Storage, Storage, Unlimited 0.1 11651.1 1,165.11
Bandwidth
21 PRICE004 [William] <1GB Storage, Unlimited Bandwidth 0.2 0.05006 0.01
22 PRICE004 [Xenos] <1GB Storage, Unlimited Bandwidth 0.2 164.355 32.87
23 PRICE008 [Yvonne] 1~10GB Storage, Storage, Unlimited 0.1 2788.97 278.90
Bandwidth
24 PRICE008 [zarif] 1~10GB Storage, Storage, Unlimited 0.1 3113.06 311.31
Bandwidth
25 PRICEO14 [Testing User 1] Trial User, Unlimited 0.01 5807.54 58.08
Bandwidth
26 PRICEO013 [Testing User 3] Trial User, 10Mb/s Bandwidth 0.02 0.05318 0.00
27 PRICEO14 [Testing User 5] Trial User, Unlimited 0.01 23.8787 0.24
Bandwidth
28 PRICEO014 [Testing User 6] Trial User, Unlimited 0.01 12916.4 129.16
Bandwidth
-Eﬂ- $20897.30
Thank you for using Online Backup!

In the user list generated by [Jun-2007], there are some users who have O storage size, and
therefore their charges are ignored. The testing users ‘Testing User 1’, ‘Testing User 3’, etc., are
trial users, and therefore they are charged at trial users’ rate.
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Enquiries
FAQ
1. 1 have received an error message called “Runtime Error” when getting users from

AhsayOBS. What does it mean?

“Runtime Error” is a very common error message and there are plenty of possibilities. At the stage
of getting users from AhsayOBS, the most likely cause is that the program cannot communicate
with AhsayOBS. Please check the connection settings mentioned in sections 1.2, 1.4 and 3.1.

2. There are some missing users in the bill generated. What could have done wrong?
Please check the logic of the pricing plan carefully in this case. It is advised to define a simpler
pricing plan if possible. You can also consider using our Hassel-free service mentioned in section
3.7.

3. | have received an error message called “Permission Denied” after generating PDF bills.
What does it mean?
The billing program converts the bill into postscript file, and then converts the postscript file to PDF.
After that the program will try to delete postscript file. If you do not have the “delete” permission in
the PDF folder, you may receive this message. The only solution is to modify the permission
settings of the folder. Otherwise you may just delete the postscript files regularly and ignore the
error.

4. | have already corrected the problems by following the user guide, but the errors still
come out. What can | do?
Every time when an error comes out, the program is terminated and cannot proceed further. One
major problem is that the calculation mode of Excel is not recovered to “automatic”, so that some
of the formula do not work and cause errors. To recover the option, from the Excel menu choose
[Tools]->[Options]->[Calculation], and then select [Automatic] in the part of [Calculation].

5. Can | modify the VBA code behind?
No, you cannot. The code is password-protected. Please contact us via our forum, if you have
special needs to modify the code.

6. What is the maximum number of records supported by the program?
There is no specific limit on the number of records. However, the Excel has limited the number of
rows by 65536. It is advised to start using another workbook if there is any worksheet which has
records exceeding 65500. Also, it is recommended to start using another workbook every year;
otherwise the large number of records can degrade the performance of the program.

7. Can I use my own code or formula to customize the program?
Yes, you are welcomed to customize the program. However, we reserve the right of not providing
support on the program if there is any modified code or changed formula.

Contact Us

For any questions on using the AhsayOBS billing program, please contact our support team by forum .
Please note that we may not be able to provide you support service if you have any modification on the
code.
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